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Getting started with STM32CubeWB for STM32WB Series

Introduction

STM32Cube is an STMicroelectronics original initiative to make developers’ lives easier by 
reducing development effort, time and cost. STM32Cube covers the whole STM32 portfolio.

STM32Cube includes:

• STM32CubeMX, a graphical software configuration tool that allows the generation of C 
initialization code using graphical wizards.

• A comprehensive embedded software platform, delivered per Series (such as 
STM32CubeWB for STM32WB Series):

– The STM32Cube HAL, STM32 abstraction layer embedded software ensuring 
maximized portability across STM32 portfolio. The HAL is available for all 
peripherals

– Low-layer APIs (LL) offering a fast light-weight expert-oriented layer which is 
closer to the hardware than the HAL. LL APIs are available only for a set of 
peripherals.

– A consistent set of middleware components such as USB Device, STMTouch 
(STM32 touch sensing library), STM32_WPAN (Bluetooth® Low Energy 5.0, 
OpenThread, 802-15-4 MAC, ZigBee), FatFS and FreeRTOS.

– All embedded software utilities coming with a full set of examples.

This user manual describes how to get started with the STM32CubeWB MCU Package.

Section 1 describes the main features of the STM32CubeWB MCU Package.

Section 2 and Section 3 provide an overview of the STM32CubeWB architecture and MCU 
Package structure.

www.st.com

http://www.st.com
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1 STM32CubeWB main features

The STM32CubeWB MCU Package runs on STM32 32-bit microcontrollers based on the 
Arm®(a) Cortex®-M processor.

STM32CubeWB gathers, in a single package, all the generic embedded software 
components required to develop an application on STM32WB microcontrollers. In line with 
the STM32Cube initiative, this set of components is highly portable, not only within 
STM32WB Series but also to other STM32 Series.

STM32CubeWB is fully compatible with STM32CubeMX code generator that allows 
generating initialization code. The package includes low-layer (LL) and hardware 
abstraction layer (HAL) APIs that cover the microcontroller hardware, together with an 
extensive set of examples running on STMicroelectronics boards. The HAL and LL APIs are 
available in open-source BSD license for user convenience.

STM32CubeWB MCU Package also contains a set of middleware components with the 
corresponding examples. They come in free user-friendly license terms:

• CMSIS-RTOS implementation with FreeRTOS™ open source solution

• Full USB Device stack supporting many classes: Audio, HID, MSC, CDC and DFU

• STMTouch, touch sensing library solution

• STM32_WPAN, wireless personal area network middleware developed within the 
STM32WB framework to support Bluetooth® Low Energy (BLE) 5.0, 802.15.4 
OpenThread certified stacks, 802-15-4 MAC layer and ZigBee.

• FAT file system based on open source FatFS solution

Several applications and demonstrations implementing all these middleware components 
are also provided in the STM32CubeWB MCU Package.

a. Arm is a registered trademark of Arm Limited (or its subsidiaries) in the US and or elsewhere.
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Figure 1. STM32CubeWB firmware components
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2 STM32CubeWB architecture overview

The STM32CubeWB firmware solution is built around three independent levels that easily 
interact as described in Figure 2.

Figure 2. STM32CubeWB firmware architecture

2.1 Level 0

This level is divided into three sub-layers: 

• Board support package (BSP)

• Hardware abstraction layer (HAL)

– HAL peripheral drivers

– Low-layer drivers

• Basic peripheral usage examples

2.1.1 Board support package (BSP)

This layer offers a set of APIs relative to the hardware components in the hardware boards 

MSv61375V1

Library and protocol based components 
(for example FatFS, USB, STMTouch, FreeRTOS™ or 

STM32_WPAN)

Examples

BSP drivers

Core drivers (optional)

Hardware abstraction layer (HAL)

HAL

Level 0

Level 1

Level 2

Low-layer (LL)

Evaluation board, Nucleo and Discovery Kit demonstrations

Applications



UM2550 Rev 4 9/36

UM2550 STM32CubeWB architecture overview

35

(such as LCD, Audio, microSD™ and MEMS drivers). It is composed of two parts:

• Component

This is the driver relative to the external device on the board and not to the STM32. The 
component driver provide specific APIs to the BSP driver external components and 
could be portable on any other board.

• BSP driver

It allows linking the component driver to a specific board and provides a set of user-
friendly APIs. The API naming rule is BSP_FUNCT_Action().

Example: BSP_LED_Init(), BSP_LED_On()

The BSP is based on a modular architecture allowing an easy porting on any hardware by 
just implementing the low-level routines.

2.1.2 Hardware abstraction layer (HAL) and low-layer (LL)

The STM32CubeWB HAL and LL are complementary and cover a wide range of 
applications requirements:

• The HAL drivers offer high-level function-oriented highly-portable APIs. They hide the 
MCU and peripheral complexity to end user.

The HAL drivers provide generic multi-instance feature-oriented APIs which simplify 
user application implementation by providing ready to use process. As example, for the 
communication peripherals (I2S, UART, and others), it provides APIs allowing 
initializing and configuring the peripheral, managing data transfer based on polling, 
interrupt or DMA process, and handling communication errors that may raise during 
communication. The HAL driver APIs are split in two categories:

– Generic APIs which provides common and generic functions to all the STM32 
Series

– Extension APIs which provides specific and customized functions for a specific 
family or a specific part number.

• The low-layer APIs provide low-level APIs at register level, with better optimization but 
less portability. They require a deep knowledge of MCU and peripheral specifications.

The LL drivers are designed to offer a fast light-weight expert-oriented layer which is 
closer to the hardware than the HAL. Contrary to the HAL, LL APIs are not provided for 
peripherals where optimized access is not a key feature, or for those requiring heavy 
software configuration and/or complex upper-level stack.

The LL drivers feature:
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– A set of functions to initialize peripheral main features according to the parameters 
specified in data structures

– A set of functions used to fill initialization data structures with the reset values 
corresponding to each field

– Function for peripheral de-initialization (peripheral registers restored to their 
default values)

– A set of inline functions for direct and atomic register access

– Full independence from HAL and capability to be used in standalone mode 
(without HAL drivers) 

– Full coverage of the supported peripheral features.

2.1.3 Basic peripheral usage examples

This layer encloses the examples build over the STM32 peripheral using only the HAL and 
BSP resources.

2.2 Level 1

This level is divided into two sub-layers:

• Middleware components

• Examples based on the middleware components.

2.2.1 Middleware components

The middleware is a set of libraries covering FatFS. FreeRTOS™, USB Device, STMTouch 
(STM32 touch sensing library), and STM32_WPAN middleware. Horizontal interactions 
between the components of this layer is done directly by calling the feature APIs while the 
vertical interaction with the low-layer drivers is done through specific callbacks and static 
macros implemented in the library system call interface. For example, the FatFS 
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implements the disk I/O driver to access microSD™ drive.

The main features of each middleware component are as follows:

• FAT file system

– FatFS FAT open source library

– Long file name support

– Dynamic multi-drive support

– RTOS and standalone operation

– Examples with microSD™

• FreeRTOS™

– Open source standard

– CMSIS compatibility layer

– Tickless operation during low-power mode

– Integration with all STM32Cube middleware modules

• USB Device library

– Support for several USB classes (Mass-Storage, HID, CDC, DFU, AUDIO and 
MTP)

– Support for multipacket transfer: large amount of data can be sent without splitting 
the transfer into transactions of maximum size packets.

– Use of configuration files to change the core and the library configuration without 
changing the read-only library code.

– RTOS and standalone operation,

– Link with low-level driver through an abstraction layer using the configuration file, 
to avoid any dependency between the library and the low-level drivers.

• STM32 touch sensing library

Robust STMTouch capacitive touch sensing solution supporting proximity, touchkey, 
linear and rotary touch sensor. It is based on a proven surface charge transfer 
acquisition principle.

• STM32 wireless personal area network middleware (STM32_WPAN) developed within 
the STM32WB framework

– BLE 5.0 certified stacks 

– BLE stack: link layer, HCI, L2CAP, ATT, SM, GAP and GATT database 
(Declaration ID D042164, available from see 
https://launchstudio.bluetooth.com)

– BLE multiprofile subsystem: a complete coverage of BLE software stack profiles 
and services (Declaration ID D042214, available from 
https://launchstudio.bluetooth.com)

– 802.15.4 Thread® v1.1 stack

The Thread® stack is provided by OpenThread, an open-source implementation of 
the Thread® networking protocol (refer to https://openthread.io for more 
information on this stack). The stack supports two configurations:

FTD (Full Thread Device), to be used for Leader, Router and End Device Thread 
roles (except for Border Router).

MTD (Minimal Thread Device), to be used for End Device and Sleepy End Device 
Thread roles.
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– 802.15.4 MAC layer

This MAC API is based on the latest official IEEE Std 802.15.4-2011 document 
available from http://grouper.ieee.org

It supports Full Function Devices (FFD) and can ensure the role of Personal Area 
Network (PAN) coordinator and Reduced Function Device (RFD) that serve as 
node for extremely simple applications.

2.2.2 ZigBee stack

ZigBee compliant platform stack (Zigbee PRO feature Set 2017).

• Support of RFD (reduced feature) and FFD configurations (full feature).

• Support of more than 40 clusters (including basic device cluster, temperature 
configuration cluster, identify cluster, on/off cluster, power profile cluster, temperature 
measurement cluster, pressure measurement cluster, meter identification cluster, 
etc…). Refer to the release note for the full list.

2.2.3 Examples based on the middleware components

Each middleware component comes with one or more examples (called also Applications) 
showing how to use it. Integration examples that use several middleware components are 
provided as well. 

2.3 Level 2

This level is composed of a single layer which consist in a global real-time and graphical 
demonstration based on the middleware service layer, the low-level abstraction layer and 
the basic peripheral usage applications for board based features.
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3 STM32CubeWB firmware package overview

3.1 Supported STM32WB devices and hardware

STM32Cube offers a highly portable hardware abstraction layer (HAL) built around a 
generic architecture. It allows the build-upon layers, such as the middleware layer, to 
implement their functions without knowing, in-depth, the MCU used. This improves the 
library code re-usability and guarantees an easy portability on other devices.

In addition, thanks to its layered architecture, the STM32CubeWB offers full support of all 
STM32WB Series. The user has only to define the right macro in stm32wbxx.h.

Table 1 shows the macro to define depending on the STM32WB device used. This macro 
must also be defined in the compiler preprocessor.

          

STM32CubeWB features a rich set of examples and applications at all levels making it easy 
to understand and use any HAL driver and/or middleware components. These examples run 
on the STMicroelectronics boards listed in Table 2.

          

The P-NUCLEO-WB55 kit contains two boards to demonstrate STM32WB connectivity 

Table 1. Macros for STM32WB Series 

Macro defined in stm32wbxx.h STM32WB devices

STM32WB10xx STM32WB10CCU

STM32WB15xx STM32WB15CCU, STM32WB15CCUxE, STM32WB15CCY

STM32WB30xx STM32WB30CEU5

STM32WB35xx
STM32WB35CEU6, STM32WB35CEY6, STM32WB35CCU6, 
STM32WB35CCY6

STM32WB50xx STM32WB50CGU5

STM32WB55xx 

STM32WB55CGU6, STM32WB55CEU6, STM32WB55CCU6, 
STM32WB55RGV6, STM32WB55REV6, STM32WB55RCV6, 
STM32WB55VGY6, STM32WB55VEY6, STM32WB55VCY6, 
STM32WB55VGQ6, STM32WB55VEQ6, STM32WB55VCQ6

STM32WB5Mxx STM32WB5MMGH6

Table 2. Boards for STM32WB Series 

Supported boards Device Kit

P-NUCLEO-WB55.Nucleo STM32WB55RG
P-NUCLEO-WB55

P-NUCLEO-WB55.USBDongle STM32WB55CG

NUCLEO-WB35CE STM32WB35CE NA

NUCLEO-WB15CC STM32WB15CC NA

 STM32WB5MM-DK STM32WB5MMG NA
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functionalities: 

• a Nucleo-68 board: P-NUCLEO-WB55.Nucleo

• a USB dongle: P-NUCLEO-WB55.USBDongle

The NUCLEO-WB35CE and P-NUCLEO-WB55.Nucleo are compatible with Adafruit® LCD 
display Arduino® UNO shields which embed a microSD™ connector and a joystick in 
addition to the LCD.

The Arduino® shield drivers are provided within the BSP component. Their usage is 
illustrated by a demonstration firmware.

The STM32CubeWB firmware is able to run on any compatible hardware. The user simply 
updates the BSP drivers to port the provided examples on his own board, if this latter has 
the same hardware features (LED, LCD display, buttons...).
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3.2 Firmware package overview

The STM32CubeWB firmware solution is provided in one single zip package having the 
structure shown in Figure 3.

Figure 3. STM32CubeWB firmware package structure
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MDK-ARM, and SW4STM32 tool-chains.

Figure 4 shows the project structure for the P-NUCLEO-WB55.Nucleo board.

Figure 4. Overview of STM32CubeWB examples 

The examples are classified depending on the STM32Cube level they apply to, and are 
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named as explained below: 

• Level 0 examples are called Examples, Examples_LL and Examples_MIX. They use 
respectively HAL drivers, LL drivers and a mix of HAL and LL drivers without any 
middleware component.

• Level 1 examples are called Applications. They provide typical use cases of each 
middleware component.

The BLE folder contains typical BLE 5.0 use cases.

The Thread folder contains typical thread use cases.

The BLE_Thread folder contains an application illustrating the switching from BLE to 
Thread and viceversa.

The BLE_ZigBee folder contains an application illustrating the switching from BLE to 
Zigbee and viceversa. 

The CKS folder contains an application which demonstrate how to use customer key 
storage feature to store AES cryptographic keys in secure area.

The Mac_802_15_4 folder contains applications which demonstrate how to use MAC 
802.15.4 Association and Data exchange.

The ZigBee folder contains applications to demonstrate the usage of clusters in 
distributed or centralized ZigBee network.

Templates projects available in the Templates and Templates_LL directories allow to quickly 
build any firmware application on a given board.

All examples have the same structure:

• \Inc folder that contains all header files.

• \Src folder for the sources code.

• \EWARM, \MDK-ARM, and \SW4STM32 folders contain the pre-configured project for 
each toolchain.

• readme.txt describing the example behavior and needed environment to make it 
working

• *.ioc file that allows users to open most of firmware examples within STM32CubeMX 
(starting from STM32CubeMX 5.1)
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4 Getting started with STM32CubeWB

4.1 Running your first example

This section explains how simple is to run a first example within STM32CubeWB. It uses as 
illustration the generation of a simple LED toggle running on P-NUCLEO-WB55.Nucleo 
board:

1. Download the STM32CubeWB firmware package. Unzip it into a directory of your 
choice. Make sure not to modify the package structure shown in Figure 3. Note that it is 
also recommended to copy the package at a location close to your root volume (e.g. 
C\Eval or G:\Tests) because some IDEs encounter problems when the path length is 
too long.

2. Browse to \Projects\NUCLEO-WB55-Nucleo\Examples.

3. Open \GPIO, then \GPIO_EXTI folders.

4. Open the project with your preferred toolchain. A quick overview on how to open, build 
and run an example with the supported toolchains is given below.

5. Rebuild all files and load your image into target memory.

6. Run the example: each time you press the user pushbutton (SW1), LED2 toggles (for 
more details, refer to the example readme file).

To open, build and run an example with the supported toolchains:, follow the steps below:

• EWARM

a) Under the example folder, open \EWARM sub-folder

b) Launch the Project.eww workspace(a)

c) Rebuild all files: Project->Rebuild all

d) Load project image: Project->Debug

e) Run program: Debug->Go(F5)

• MDK-ARM

a) Under the example folder, open \MDK-ARM sub-folder

b) Launch the Project.uvprojx workspace(a)

c) Rebuild all files: Project->Rebuild all target files

d) Load project image: Debug->Start/Stop Debug Session

e) Run program: Debug->Run (F5).

a. The workspace name may change from one example to another.
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• SW4STM32

a) Open the SW4STM32 toolchain

b) Click File->Switch Workspace->Other and browse to the SW4STM32 
workspace directory

c) Click File->Import, select General->Existing Projects into Workspace and then 
click Next

d) Browse to the SW4STM32 workspace directory and select the project

e) Rebuild all project files: select the project in the Project explorer window then 
click the Project->build project menu

f) Run program: Run->Debug (F11)

4.2 Developing your own application

4.2.1 Using STM32CubeMX to develop or update your application

In the STM32CubeWB MCU Package, all Example projects are generated with the 
STM32CubeMX tool to initialize the system, peripherals and middleware.

The direct use of an existing Example project from within STM32CubeMX requires 
STM32CubeMX 5.1 or higher:

• After the installation of STM32CubeMX, open and eventually update a proposed 
project. The simplest way to open an existing project is to double-click on the *.ioc file 
so that STM32CubeMX automatically opens the project and its source files.

• The initialization source code of such projects is generated by STM32CubeMX; the 
main application source code is delimited by comments USER CODE BEGIN and USER 
CODE END. In case of a modification of the IP selection and setting, STM32CubeMX 
updates the initialization part of the code but preserves the main application source 
code.

For developing an own project in STM32CubeMX, follow the step-by-step process:

1. Select the STMicroelectronics STM32 microcontroller that matches the required set of 
peripherals.

2. Configure each required embedded software thanks to a pinout-conflict solver, a clock-
tree setting helper, a power consumption calculator, and the utility performing MCU 
peripheral configuration (such as GPIO or USART) and middleware stacks (such as 
USB).

3. Generate the initialization C code based on the configuration selected. This code is 
ready to use within several development environments. The user code is kept at the 
next code generation.

For more information about STM32CubeMX, refer to the STM32CubeMX for STM32 
configuration and initialization C code generation (UM1718) user manual.

For a list of the Example projects available in STM32CubeWB, and their content, refer to the 
STM32Cube firmware examples for STM32WB Series application note (AN5155).
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4.2.2 HAL application

This section describes the steps required to create your own HAL application using 
STM32CubeWB:

1. Create your project

To create a new project, you either start from the Template project provided for each 
board under \Projects\<STM32xxx_yyy>\Templates or from any available project under 
\Projects\<STM32xxy_yyy>\Examples or \Projects\<STM32xx_yyy>\Applications 
(where <STM32xxx_yyy> refers to the board name, such as P-NUCLEO-
WB55.Nucleo).

The Template project is providing empty main loop function, however it is a good 
starting point to get familiar with project settings for STM32CubeWB. The template has 
the following characteristics:

– It contains the source code of HAL, CMSIS and BSP drivers which are the minimal 
components required to develop a code on a given board.

– It contains the include paths for all the firmware components.

– It defines the STM32WB device supported, thus allowing to configure the CMSIS 
and HAL drivers accordingly.

– It provides read-to-use user files pre-configured as shown below:

HAL initialized with default time base with ARM Core SysTick.

SysTick ISR implemented for HAL_Delay() purpose.

Note: When copying an existing project to another location, make sure to update the 
include paths.

2. Add the necessary middleware to your project (optional) 
The available middleware stacks are: FatFS, FreeRTOS™, USB Device, STMTouch 
and STM32_WPAN. To know which source files must be added to the project file list, 
refer to the documentation provided for each middleware. It is possible to look at the 
applications available under \Projects\STM32xxx_yyy\Applications\<MW_Stack> 
(where <MW_Stack> refers to the middleware stack, such as USB_Device) to know 
which source files and which include paths must be added.

3. Configure the firmware components 
The HAL and middleware components offer a set of build time configuration options 
using macros # define declared in a header file. A template configuration file is 
provided within each component, it has to be copied to the project folder (usually the 
configuration file is named xxx_conf_template.h, the word ‘_template’ needs to be 
removed when copying it to the project folder). The configuration file provides enough 
information to know the impact of each configuration option. More detailed information 
is available in the documentation provided for each component.
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4. Start the HAL Library 
After jumping to the main program, the application code must call HAL_Init() API to 
initialize the HAL Library, which do the following tasks:

a) Configuration of the Flash prefetch and SysTick interrupt priority (through macros 
defined in stm32wbxx_hal_conf.h).

b) Configuration of the SysTick to generate an interrupt every millisecond at the 
SysTick interrupt priority TICK_INT_PRIO defined in stm32wbxx_hal_conf.h.

c) Setting of NVIC Group Priority to 0.

d) Call of HAL_MspInit() callback function defined in stm32wbxx_hal_msp.c user 
file to perform global low-level hardware initializations.

5. Configure the system clock

The system clock configuration is done by calling the two APIs described below:

a) HAL_RCC_OscConfig(): this API configures the internal and/or external 
oscillators, as well as the PLL source and factors. The user chooses to configure 
one oscillator or all oscillators. The PLL configuration can be skipped if there is no 
need to run the system at high frequency.

b) HAL_RCC_ClockConfig(): this API configures the system clock source, the 
Flash memory latency and AHB and APB prescalers.

6. Initialize the peripheral

a) First write the peripheral HAL_PPP_MspInit function. Proceed as follows:

- Enable the peripheral clock.

- Configure the peripheral GPIOs.

- Configure the DMA channel and enable DMA interrupt (if needed).

- Enable peripheral interrupt (if needed).

b) Edit the stm32xxx_it.c to call the required interrupt handlers (peripheral and DMA), 
if needed.

c) Write process complete callback functions if you plan to use peripheral interrupt or 
DMA.

d) In your main.c file, initialize the peripheral handle structure then call the function 
HAL_PPP_Init() to initialize your peripheral.

7. Develop your application

At this stage, your system is ready and you start developing your application code. 

– The HAL provides intuitive and ready-to-use APIs to configure the peripheral. It 
supports polling, interrupts and DMA programming model, to accommodate 
any application requirements. For more details on how to use each peripheral, 
refer to the rich examples set provided in the STM32CubeWB MCU package.

– If your application has some real-time constraints, you find a large set of examples 
showing how to use FreeRTOS™ and integrate it with all middleware stacks 
provided within STM32CubeWB. This is a good starting point to develop your 
application.

Caution: In the default HAL implementation, SysTick timer is used as timebase: it generates 
interrupts at regular time intervals. If HAL_Delay() is called from peripheral ISR process, 
make sure that the SysTick interrupt has higher priority (numerically lower) than the 
peripheral interrupt. Otherwise, the caller ISR process will be blocked. Functions affecting 
timebase configurations are declared as __weak to make override possible in case of other 
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implementations in user file (using a general purpose timer for example or other time 
source). For more details, refer to HAL_TimeBase example.

4.2.3 LL application

This section describes the steps needed to create your own LL application using 
STM32CubeWB.

1. Create your project

To create a new project you either start from the Templates_LL project provided for 
each board under \Projects\<STM32xxx_yyy>\Templates_LL or from any available 
project under \Projects\<STM32xxy_yyy>\Examples_LL (<STM32xxx_yyy> refers to 
the board name, such as P-NUCLEO-WB55.Nucleo).

The Template project provides an empty main loop function, however it is a good 
starting point to get familiar with project settings for STM32CubeWB. 

Template main characteristics are the following: 

– It contains the source codes of the LL and CMSIS drivers which are the minimal 
components needed to develop code on a given board.

– It contains the include paths for all the required firmware components.

– It selects the supported STM32WB device and allows to configure the CMSIS and 
LL drivers accordingly.

– It provides ready-to-use user files, that are pre-configured as follows:

main.h: LED & USER_BUTTON definition abstraction layer.

main.c: System clock configuration for maximum frequency. 

2. Port an existing project to another board

To port an existing project to another target board, start from the Templates_LL project 
provided for each board and available under 
\Projects\<STM32xxx_yyy>\Templates_LL:

a) Select a LL example

To find the board on which LL examples are deployed, refer to the list of LL 
examples STM32CubeProjectsList.html or to application note “STM32Cube 
firmware examples for STM32WB Series” (AN5155).

b) Port the LL example

– Copy/paste the Templates_LL folder - to keep the initial source - or directly update 
existing Templates_LL project.

– Then porting consists principally in replacing Templates_LL files by the 
Examples_LL targeted project.

– Keep all board specific parts. For reasons of clarity, board specific parts have been 
flagged with specific tags:

/* =========   BOARD SPECIFIC CONFIGURATION CODE BEGIN ========== */

/* ==========   BOARD SPECIFIC CONFIGURATION CODE END      ============ */

Thus the main porting steps are the following:
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– Replace the stm32wbxx_it.h file

– Replace the stm32wbxx_it.c file

– Replace the main.h file and update it: keep the LED and user button definition of 
the LL template under ‘BOARD SPECIFIC CONFIGURATION’ tags.

– Replace the main.c file and update it:

Keep the clock configuration of the SystemClock_Config() LL template 
function under ‘BOARD SPECIFIC CONFIGURATION’ tags.

Depending on LED definition, replace each LEDx occurrence with another LEDy 
available in main.h.

Thanks to these adaptations, the example should be functional on the targeted board.

4.2.4 Installing and running the STM32CubeUpdater program 

Follow the sequence below to install and run the STM32CubeUpdater:

1. To launch the installation, double-click the SetupSTM32CubeUpdater.exe file.

2. Accept the license terms and follow the different installation steps.

3. Upon successful installation, STM32CubeUpdater becomes available as an 
STMicroelectronics program under Program Files and is automatically launched. The 
STM32CubeUpdater icon appears in the system tray. Right-click the updater icon and 
select ‘Updater Settings’ to configure the Updater connection and whether to perform 
manual or automatic checks. For more details on Updater configuration, refer to 
section 3 of STM32CubeMX for STM32 configuration and initialization C code 
generation (UM1718) user manual.
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5 How to flash the wireless coprocessor binary

The STM32CubeWB firmware package contains several wireless stack binaries located 
under Projects\STM32WB_Copro_Wireless_Binaries.

STM32WB5x (Projects\STM32WB_Copro_Wireless_Binaries\STM32WB5x)

The supported binaries are the following:

• - stm32wb5x_BLE_HCI_AdvScan_fw.bin 

– HCI Layer only mode 5.2 certified: Link Layer, HCI

– BT SIG Certification listing: Declaration ID D042213 
Usage: advertising and scanning through HCI interface

• stm32wb5x_BLE_LLD_fw.bin

– BLE LLD (low level driver) radio transparent firmware  
Usage: direct access on BLE LLD features and API

• stm32wb5x_BLE_Stack_full_fw.bin

– Full BLE stack, certified 5.2: link layer, HCI, L2CAP, ATT, SM, GAP and GATT 
database

– BT SIG certification listing: declaration ID D042164

– Following features are kept:

GAP peripheral, central (LL master up to 6 links with slave up to 2 links/ master up 
to 7 links with slave up to 1 links/ Master up to 8 links) 
GATT server, client 
Data length extension 
2Mbit PHY / PHY update 
Privacy  
White list 
Legacy pairing, LE secure connections 
HCI interface (full, like stm32wb5x_BLE_HCILayer_fw.bin) 
Direct test mode

• stm32wb5x_BLE_Stack_light_fw.bin

– Full BLE stack 5.2 certified: link layer, HCI, L2CAP, ATT, SM, GAP and GATT 
database 

– BT SIG Certification listing: Declaration ID D042164

– Wireless BLE stack light configuration – slave only

– Following features are kept:

GAP peripheral only (LL slave up to 2 links) 
GATT server 
Data length extension 
Privacy  
White list 
Legacy pairing, LE secure connections  
HCI interface (reduced) 
Direct test mode

– BLE slave only stack implies that with this stack configuration, STM32WB is not 
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able to scan and request a BLE connection. 

– It just advertise, and accept incoming connection request from other master 
devices (e.g. smartphone) (slave up to 2 links). 

– While with the full feature BLE stack, STM32WB5xx is able to support both master 
and slave roles on different links (with the limitation of max 8 links in parallel, 
from which max 2 slave links).

• stm32wb5x_BLE_Stack_basic_fw.bin 

– Full BLE stack 5.2 certified: link layer, HCI, L2CAP, ATT, SM, GAP and GATT 
database

– BT SIG certification listing: Declaration ID D042164

– Wireless BLE stack basic configuration 

– Following features are kept:

GAP peripheral and central (8 links - LL slave up to 2 links)

ATT server, client

Data length extension

Privacy 

White list

Legacy Pairing, LE secure connections 

HCI interface (reduced)

– Following features are removed from Full BLE Stack:

L2Cap Connection - oriented channel (Chip/ Ip over BLE,...)

Additional beacon

Some HCI interface features (no be able to process through HCI interface)

Phy update (2Mb/s)

Direct test mode

Extended Advertising

• stm32wb5x_BLE_HCILayer_fw.bin

– HCI layer, only mode 5.2 certified: link layer and HCI with direct test mode

– BT SIG certification listing: declaration ID D042213

• stm32wb5x_Thread_FTD_fw.bin

– Full thread device, certified v1.1

Usage: Leader, router and end device thread roles (full featured except for border 
router)

• stm32wb5x_Thread_MTD_fw.bin

– Minimal thread device, certified v1.1.

Usage: End device and sleepy end device thread role

• stm32wb5x_Thread_RCP_fw.bin

– Open thread radio co-processor (RCP) 
Usage: Thread border router setup.

– Application layer and Open thread core on the host processor, minimal open 
thread MAC on the 802.15.4 SoC. 

– Communication between the RCP and the host processor is managed by open 
thread daemon through an SPI interface over the Spinel protocol.
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• stm32wb5x_BLE_Thread_static_fw.bin

– Static concurrent mode BLE thread 

– Supports full BLE stack 5.2 certified and full thread device certified v1.1

• stm32wb5x_BLE_Thread_dynamic.bin

– Dynamic concurrent mode BLE thread 

– Supports full BLE stack 5.2 certified and full thread device certified v1.1

• stm32wb5x_Mac_802_15_4_fw.bin

– MAC API based on the latest official IEEE Std 802.15.4-2011

Usage: MAC FFD and RFD devices

• stm32wb5x_phy802_15_4_fw.bin 

– 802.15.4 features exposed on application side

– Reduced number of commands called from application side to manage 802.15.4 
API

– Not a transparent mode, 802.15.4 API not deployed on application side

– Can be used with STM32CubeMonitor-RF application or dedicated M4 
application.

• stm32wb5x_Zigbee_FFD_fw.bin

– Zigbee compliant platform certified.

Supports: full function device (FFD)

• stm32wb5x_Zigbee_RFD_fw.bin 

– Zigbee Reduced Function Device

– Zigbee Compliant Platform certified 
Usage: end device Zigbee role

• stm32wb5x_BLE_Mac_802_15_4_fw.bin

– Static concurrent mode BLE MAC 802.15.4. 
Supports: Full BLE stack 5.2 certified and MAC 802.15.4 API based on latest 
official IEEE Std 802.15.4-2011

• stm32wb5x_BLE_Zigbee_FFD_static_fw.bin 

– Static Concurrent Mode BLE Zigbee

Supports: full BLE Stack 5.2 certified and Zigbee FFD compliant platform certified

• stm32wb5x_BLE_Zigbee_RFD_static_fw.bin

– Static concurrent mode BLE Zigbee RFD

Supports full BLE stack 5.2 certified and Zigbee RFD (reduced function device) 
compliant platform certified

– Optimized for power consumption.

• stm32wb5x_BLE_Zigbee_FFD_dynamic_fw.bin

– Dynamic Concurrent Mode BLE Zigbee FFD

Supports full BLE stack 5.2 certified and Zigbee FFD (full function device) 
compliant platform certified

• stm32wb5x_BLE_Zigbee_RFD_dynamic_fw.bin

– Dynamic concurrent mode BLE Zigbee RFD
Supports full BLE stack 5.0 certified and Zigbee RFD (reduced function device) 
compliant platform certified
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– Optimized for power consumption.

STM32WB3x (Projects\STM32WB_Copro_Wireless_Binaries\STM32WB3x)

The supported binaries are the following:

• - stm32wb3x_BLE_HCI_AdvScan_fw.bin 

– HCI Layer only mode 5.2 certified: Link Layer, HCI

– BT SIG Certification listing: Declaration ID D042213 
Usage: advertising and scanning through HCI interface

• stm32wb3x_BLE_LLD_fw.bin

– BLE LLD (low level driver) radio transparent firmware  
Usage: direct access on BLE LLD features and API

• stm32wb3x_BLE_Stack_full_fw.bin

– Full BLE stack, certified 5.2: link layer, HCI, L2CAP, ATT, SM, GAP and GATT 
database

– BT SIG certification listing: declaration ID D042164

– Following features are kept:

GAP peripheral, central (LL master up to 6 links with slave up to 2 links/ master up 
to 7 links with slave up to 1 links/ Master up to 8 links)

GATT server, client

Data length extension

2Mbit PHY / PHY update

Privacy 

White list

Legacy pairing, LE secure connections

HCI interface (full, like stm32wb5x_BLE_HCILayer_fw.bin)

Direct test mode

• stm32wb3x_BLE_Stack_light_fw.bin

– Full BLE stack 5.2 certified: link layer, HCI, L2CAP, ATT, SM, GAP and GATT 
database 

– BT SIG Certification listing: Declaration ID D042164

– Wireless BLE stack light configuration – slave only

– Following features are kept:

GAP peripheral only (LL slave up to 2 links)

GATT server

Data length extension

Privacy 

White list

Legacy pairing, LE secure connections 

HCI interface (reduced)

Direct test mode

– BLE slave only stack implies that with this stack configuration, STM32WB is not 
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able to scan and request a BLE connection. 

– It just advertise, and accept incoming connection request from other master 
devices (e.g. smartphone) (slave up to 2 links). 

– While with the full feature BLE stack, STM32WB3xx is able to support both master 
and slave roles on different links

• stm32wb3x_BLE_Stack_basic_fw.bin 

– Full BLE stack 5.2 certified: link layer, HCI, L2CAP, ATT, SM, GAP and GATT 
database

– BT SIG certification listing: Declaration ID D042164

– Wireless BLE stack basic configuration 

– Following features are kept:

GAP peripheral and central (8 links - LL slave up to 2 links)

GATT server, client

Data length extension

Privacy 

White list

Legacy Pairing, LE secure connections 

HCI interface (reduced)

– Following features are removed from Full BLE Stack:

L2Cap Connection - oriented channel (Chip/ Ip over BLE,...)

Additional beacon

Some HCI interface features (no be able to process through HCI interface)

Phy update (2Mb/s)

Direct test mode

Extended Advertising

• stm32wb3x_BLE_HCILayer_fw.bin

– HCI layer, only mode 5.2 certified: link layer and HCI with direct test mode

– BT SIG certification listing: declaration ID D042213

• stm32wb3x_Thread_FTD_fw.bin

– Full thread device, certified v1.1

Usage: Leader, router and end device thread roles (full featured except for border 
router)

• stm32wb3x_Thread_MTD_fw.bin

– Minimal thread device, certified v1.1.

Usage: End device and sleepy end device thread role

• stm32wb3x_Thread_RCP_fw.bin

– Open thread radio co-processor (RCP) 
Usage: Thread border router setup.

– Application layer and Open thread core on the host processor, minimal open 
thread MAC on the 802.15.4 SoC. 
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– Communication between the RCP and the host processor is managed by open 
thread daemon through an SPI interface over the Spinel protocol.

• stm32wb3x_Mac_802_15_4_fw.bin

– MAC API is based on latest official IEEE Std 802.15.4-2011

Usage: MAC FFD and RFD devices

• stm32wb3x_phy802_15_4_fw.bin 

– 802.15.4 features exposed on application side

– Reduced number of commands called from application side to manage 802.15.4 
API

– Not a transparent mode, 802.15.4 API not deployed on application side

– Can be used with STM32CubeMonitor-RF application or dedicated M4 
application.

• stm32wb3x_Zigbee_FFD_fw.bin

– Zigbee compliant platform certified.

Supports: full function device (FFD)

• stm32wb3x_Zigbee_RFD_fw.bin 

– Zigbee Reduced Function Device

– Zigbee Compliant Platform certified 
Usage: end device Zigbee role

• stm32wb3x_BLE_Mac_802_15_4_fw.bin

Static concurrent mode BLE MAC 802.15.4. 
Supports: Full BLE stack 5.2 certified and MAC 802.15.4 API based on latest 
official IEEE Std 802.15.4-2011

STM32WB1x (Projects\STM32WB_Copro_Wireless_Binaries\STM32WB1x)

The supported binaries are the following:

• - stm32wb1x_BLE_HCI_AdvScan_fw.bin 

– HCI Layer only mode 5.2 certified: Link Layer, HCI

– BT SIG Certification listing: Declaration ID D042213 
Usage: advertising and scanning through HCI interface

• stm32wb1x_BLE_LLD_fw.bin

– BLE LLD (low level driver) radio transparent firmware  
Usage: direct access on BLE LLD features and API

• stm32wb1x_BLE_Stack_full_fw.bin

– Full BLE stack, certified 5.2: link layer, HCI, L2CAP, ATT, SM, GAP and GATT 
database

– BT SIG certification listing: declaration ID D042164

– Following features are kept:

GAP peripheral, central (LL master up to 6 links with slave up to 2 links/ master up 
to 7 links with slave up to 1 links/ Master up to 8 links)

GATT server, client

Data length extension

2Mbit PHY / PHY update

Privacy 
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White list

Legacy pairing, LE secure connections

HCI interface (full, like stm32wb5x_BLE_HCILayer_fw.bin)

Direct test mode

• stm32wb1x_BLE_Stack_light_fw.bin

– Full BLE stack 5.2 certified: link layer, HCI, L2CAP, ATT, SM, GAP and GATT 
database 

– BT SIG Certification listing: Declaration ID D042164

– Wireless BLE stack light configuration – slave only

– Following features are kept:

GAP peripheral only (LL slave up to 2 links)

GATT server

Data length extension

Privacy 

White list

Legacy pairing, LE secure connections

HCI interface (reduced)

Direct test mode

– BLE slave only stack implies that with this stack configuration, STM32WB is not 
able to scan and request a BLE connection. 

– It just advertise, and accept incoming connection request from other master 
devices (e.g. smartphone) (slave up to 2 links). 

– While with the full feature BLE stack, STM32WB1xx is able to support both master 
and slave roles on different links

• stm32wb1x_BLE_Stack_basic_fw.bin 

– Full BLE stack 5.2 certified: link layer, HCI, L2CAP, ATT, SM, GAP and GATT 
database

– BT SIG certification listing: Declaration ID D042164

– Wireless BLE stack basic configuration 

– Following features are kept:

GAP peripheral and central (8 links - LL slave up to 2 links)

GATT server, client

Data length extension

Privacy 

White list

Legacy Pairing, LE secure connections 

HCI interface (reduced)



UM2550 Rev 4 31/36

UM2550 How to flash the wireless coprocessor binary

35

– Following features are removed from Full BLE Stack:

L2Cap Connection - oriented channel (Chip/ Ip over BLE,...)

Additional beacon

Some HCI interface features (no be able to process through HCI interface)

Phy update (2Mb/s)

Direct test mode

Extended Advertising

• stm32wb1x_BLE_HCILayer_fw.bin

– HCI layer, only mode 5.2 certified: link layer and HCI with direct test mode

– BT SIG certification listing: declaration ID D042213
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6 FAQ

6.1 What is the license scheme for the STM32CubeWB 
firmware?

The HAL is distributed under a non-restrictive BSD (Berkeley Software Distribution) license.

The middleware stacks made by STMicroelectronics (USB Device Libraries, STemWin, 
STM32_WPAN) come with a licensing model allowing easy reuse, provided it runs on an 
STMicroelectronics device.

The middleware based on well-known open-source solutions (FreeRTOS™ and FatFS) 
have user-friendly license terms. For more details, refer to the license agreement of each 
middleware.

6.2 What boards are supported by the STM32CubeWB firmware 
package?

The STM32CubeWB firmware package provides BSP drivers and ready-to-use examples 
for the following STM32WB boards:

• P-NUCLEO-WB55.Nucleo

• P-NUCLEO-WB55.USBDongle

• NUCLEO-WB35CE

6.3 Are any examples provided with the ready-to-use toolset 
projects?

Yes. STM32CubeWB provides a rich set of examples and applications. They come with the 
pre-configured projects for IAR™, Keil® and GCC-based toolchains.

6.4 Is there any link with Standard Peripheral Libraries?

The STM32Cube HAL and LL drivers are the replacement of the standard peripheral library: 

• The HAL drivers offer a higher abstraction level compared to the standard peripheral 
APIs. They focus on peripheral common features rather than hardware. Their higher 
abstraction level allows defining a set of user-friendly APIs that are easily portable from 
one product to another.

• The LL drivers offer low-layer APIs at registers level. They are organized in a simpler 
and clearer way than direct register accesses. LL drivers also include peripheral 
initialization APIs, which are more optimized compared to what is offered by the SPL, 
while being functionally similar. Compared to HAL drivers, these LL initialization APIs 
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allows an easier migration from the SPL to the STM32Cube LL drivers, since each SPL 
API has its equivalent LL API(s).

6.5 Does the HAL layer take benefit from interrupts or DMA? 
How can this be controlled?

Yes. The HAL layer supports three API programming models: polling, interrupt and DMA 
(with or without interrupt generation). 

6.6 How are the product/peripheral specific features managed?

The HAL drivers offer extended APIs, i.e. specific functions as add-ons to the common API 
to support features available on some products/lines only.

6.7 How can STM32CubeMX generate code based on embedded 
software?

STM32CubeMX has a built-in knowledge of STM32 microcontrollers, including their 
peripherals and software, that allows to provide a graphical representation to the user and 
generate *.h/*.c files based on user configuration.

6.8 When should I use HAL versus LL drivers?

HAL drivers offer high-level and function-oriented APIs, with a high level of portability. 
Product/IPs complexity is hidden for end users.

LL drivers offer low-layer APIs at registers level, with a better optimization but less 
portability. They require a deep knowledge of product/IPs specifications.

6.9 How can I include LL drivers in my environment?  
Is there any LL configuration file as for HAL?

There is no configuration file. Source code shall directly include the necessary 
stm32wbxx_ll_ppp.h file(s).

6.10 Can I use HAL and LL drivers together? If yes, what are the 
constraints?

It is possible to use both HAL and LL drivers. One handles the IP initialization phase with 
HAL and then manages the I/O operations with LL drivers.

The major difference between HAL and LL is that HAL drivers require to create and use 
handles for operation management while LL drivers operates directly on peripheral 
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registers. Mixing HAL and LL is illustrated in Examples_MIX example.

6.11 Are there any LL APIs which are not available with HAL?

Yes, there are.

A few Cortex® APIs have been added in stm32wbxx_ll_cortex.h , for instance for accessing 
SCB or SysTick registers.

6.12 Why are SysTick interrupts not enabled on LL drivers?

When using LL drivers in standalone mode, you do not need to enable SysTick interrupts 
because they are not used in LL APIs, while HAL functions requires SysTick interrupts to 
manage timeouts.

6.13 How are LL initialization APIs enabled?

The definition of LL initialization APIs and associated resources (structure, literals and 
prototypes) is conditioned by the USE_FULL_LL_DRIVER compilation switch.

To be able to use LL APIs, add this switch in the toolchain compiler preprocessor.
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7 Revision history

          

Table 3. Document revision history

Date Revision Changes

06-Feb-2019 1 Initial release.

24-Jun-2019 2 Updated Table 1: Macros for STM32WB Series.

28-Feb-2020 3

Added: 

– ZigBee reference in Introduction, Section 1: 
STM32CubeWB main features

– Section 2.2.2: ZigBee stack

Updated:

– Table 1: Macros for STM32WB Series, Table 2: 
Boards for STM32WB Series

– Figure 3: STM32CubeWB firmware package 
structure, Figure 4: Overview of STM32CubeWB 
examples

– Section 3.2: Firmware package overview, Section 5: 
How to flash the wireless coprocessor binary, 
Section 6.2: What boards are supported by the 
STM32CubeWB firmware package?

06-Jun-2021 4
Updated: Table 1: Macros for STM32WB Series, 
Table 2: Boards for STM32WB Series and Section 5: 
How to flash the wireless coprocessor binary
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